
 

  

OpenTTCN Tester 2011 
User Guide 

VERSION 4.1.6 ï April 25, 2012 

 



 

Page 2 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

Contents 

1 OVERVIEW OF OPENTTCN TESTER 2011 .................................................................................... 5 

2 RELEASE HIGHLIGHTS OF OPENTTCN TESTER 2011 .................................................................... 6 

3 PREREQUISITES FOR OPENTTCN TESTER ................................................................................... 7 

4 OPENTTCN TESTER SYSTEM OVERVIEW .................................................................................... 8 

4.1 SYSTEM SERVICES ............................................................................................................................ 8 

4.2 USER INTERFACES ............................................................................................................................ 8 

4.3 SUT AND PLATFORM ADAPTERS AND CODING AND DECODING ................................................................ 9 

4.3.1 SUT Adapter .................................................................................................................... 10 

4.3.2 Platform Adapter ............................................................................................................ 10 

4.3.3 Coding and Decoding ...................................................................................................... 11 

5 STARTING AND STOPPING OPENTTCN TESTER ........................................................................ 12 

5.1 SELECTING A WORKSPACE ............................................................................................................... 13 

5.2 INSTALLING OPENTTCN LICENSE KEY ................................................................................................ 14 

5.3 ACTIVATING OPENTTCN LICENSE KEY ............................................................................................... 15 

5.4 PROXY CONFIGURATION .................................................................................................................. 18 

5.5 ONLINE LICENSE VALIDATION .......................................................................................................... 19 

5.6 OPENTTCN TESTER RUNNING ......................................................................................................... 21 

5.7 STOPPING OPENTTCN TESTER ........................................................................................................ 24 

6 TRYING OPENTTCN TESTER WITH DEMO3 EXAMPLE ............................................................... 26 

6.1 EXPECTED RESULTS OF DEMO3 TEST CAMPAIGN ................................................................................. 30 

6.2 EXPECTED RESULTS OF DNS_EXAMPLE TEST CAMPAIGN ........................................................................ 30 

6.3 EXPECTED RESULTS OF ASN1 TEST CAMPAIGN ................................................................................... 31 

7 STARTING A NEW TTCN-3 PROJECT ......................................................................................... 32 

7.1 CREATING A TTCN-3 PROJECT......................................................................................................... 32 

7.2 CREATING A TTCN-3 FILE ............................................................................................................... 35 

7.3 IMPORTING TTCN-3 FILE(S) ........................................................................................................... 37 

7.4 CREATING A PARAMETER FILE .......................................................................................................... 39 

7.5 COMPILING TTCN-3 CODE ............................................................................................................. 40 

7.6 SETTING TTCN-3 ADAPTER CONFIGURATION (EXTERNAL TOOLS CONFIGURATION) ................................... 44 

7.7 SETTING UP TTCN-3 TEST CAMPAIGN (RUN CONFIGURATION) ............................................................. 46 

7.8 RUNNING TTCN-3 TEST CASES ........................................................................................................ 49 

8 ANALYZING TEST RESULTS ...................................................................................................... 50 



 

Page 3 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

8.1 STACK TRACE VIEW ........................................................................................................................ 50 

9 JAVA ADAPTER DEVELOPMENT USING OPENTTCN TESTER 2011 GUI ...................................... 52 

9.1 OVERVIEW ................................................................................................................................... 52 

9.2 IMPORTING A JAVA PROJECT ............................................................................................................ 52 

9.3 SETTING UP JAVA COMPILATION ....................................................................................................... 54 

9.4 RUNNING JAVA ADAPTERS ............................................................................................................... 57 

Option 1: OpenTTCN adapter launch configuration ...................................................................... 57 

Option 2: Start as Java application ............................................................................................... 57 

10 COMMAND-LINE TOOLS QUICK REFERENCE ............................................................................ 60 

10.1 CONTROLLING SYSTEM SERVICES ................................................................................................. 60 

10.2 SESSION MANAGEMENT ............................................................................................................ 60 

10.3 LOADING MODULES................................................................................................................... 60 

10.4 RUNNING TEST CASES ................................................................................................................ 61 

10.5 LOADING VALUES OF MODULE OR TEST SUITE PARAMETERS ............................................................... 61 

10.6 HANDLING ERRORS ................................................................................................................... 61 

10.7 TYPICAL COMMANDS SEQUENCES ................................................................................................ 62 

11 TESTING USING OPENTTCN TESTER COMMAND-LINE ............................................................. 63 

11.1 STARTING TEST SYSTEM ............................................................................................................. 63 

11.1.1 Starting the Server Part of OpenTTCN Tester ............................................................. 64 

11.1.2 Starting SUT and Platform Adapters and Coding and Decoding ................................ 64 

11.2 SELECTING TESTING SESSION ...................................................................................................... 65 

11.3 LOADING (COMPILING) TTCN-3 AND ASN.1 MODULES .................................................................. 66 

11.4 SETTING UP TESTER FOR TESTING NEW IMPLEMENTATION ............................................................... 68 

11.5 CHECKING FEASIBILITY OF STARTING FULL TESTING ......................................................................... 70 

11.6 RUNNING ALL TESTS ................................................................................................................. 70 

11.6.1 Stopping Test Campaign ............................................................................................ 71 

11.7 REVIEWING TESTS RESULTS ........................................................................................................ 72 

11.7.1 Reviewing Test Result Summary ................................................................................ 72 

11.7.2 Reviewing Assigned Verdicts ...................................................................................... 74 

11.8 STOPPING TEST SYSTEM ............................................................................................................. 76 

11.8.1 Stopping SUT and Platform Adapters and Coding and Decoding .............................. 76 

11.8.2 Stopping the Server Part of OpenTTCN Tester ........................................................... 77 

12 OPENTTCN COMMAND-LINE REFERENCE ................................................................................ 78 

12.1 THE άOTέ SERVER START-UP UTILITY ........................................................................................... 78 



 

Page 4 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

12.1.1 Start a Testing Server ................................................................................................. 78 

12.1.2 Stop a Testing Server .................................................................................................. 79 

12.1.3 Inquiry of a Testing Server Status............................................................................... 79 

12.1.4 Print License Key OpenTTCN Identification ................................................................ 80 

12.1.5 Print Command-Line Help .......................................................................................... 80 

12.2 SESSION UTILITY ....................................................................................................................... 80 

12.2.1 Create a Session ......................................................................................................... 81 

12.2.2 Delete a Session ......................................................................................................... 82 

12.2.3 List Sessions ................................................................................................................ 82 

12.2.4 Show a Session Status ................................................................................................ 83 

12.2.5 Unregister a Test System Interface ............................................................................ 83 

12.2.6 Print Version Information ........................................................................................... 85 

12.2.7 Print Command-Line Help .......................................................................................... 85 

12.3 TESTER UTILITY ........................................................................................................................ 86 

12.3.1 Run Tests .................................................................................................................... 86 

12.3.2 Print Version Information ........................................................................................... 87 

12.3.3 Print Command-Line Help .......................................................................................... 87 

12.4 IMPORTER3 UTILITY .................................................................................................................. 88 

12.4.1 Load Test Suite ........................................................................................................... 88 

12.4.2 Analyse a Test Suite ................................................................................................... 89 

12.4.3 Suite Using TTCN-3 Module Parameters .................................................................... 89 

12.4.4 Print Command-Line Help .......................................................................................... 90 

13 OPENTTCN TESTER CONFIGURATION FILE ............................................................................... 91 

13.1 CHANGING CONFIGURATION SETTINGS .......................................................................................... 92 

13.2 COMMONLY USED CONFIGURATION SETTINGS ................................................................................ 92 

13.3 JAVA RELATED CONFIGURATION SETTINGS ...................................................................................... 92 

13.4 SYSTEM CONFIGURATION SETTINGS .............................................................................................. 94 

14 CONTACTING OPENTTCN ........................................................................................................ 95 

 

  



 

Page 5 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

1 Overview of OpenTTCN Tester 2011 

 

OpenTTCN Tester 2011 is a TTCN-3 test development and execution package built 

by integrating popular OpenTTCN Tester product and widely used Eclipse framework 

providing an easy to use TTCN-3 editing, compilation, and execution environment. 

 

OpenTTCN Tester 2011 includes seamless integration of OpenTTCN TTCN-3 just-

in-time compiler, OpenTTCN TTCN-3 virtual machine, and TTCN-3 editor. 

OpenTTCN Tester 2011 provides basic but easy to use support for integrating TTCN-

3 test case editing, TTCN-3 syntax and semantic checking, TTCN-3 compilation, 

starting TTCN-3 adapters on demand and execution of TTCN-3 test cases into one 

single integrated development environment. 

 

OpenTTCN Tester 2011 is compatible with OpenTTCN platform version 4.1. The 

following OpenTTCN SDKs are included for programming TTCN-3 adapters: 

¶ OpenTTCN SDK for C
1
 

¶ OpenTTCN SDK for C++
2
 

¶ OpenTTCN SDK for C#
3
 

¶ OpenTTCN SDK for Java 

 

Currently, OpenTTCN Tester 2011 is available for Windows and Linux platform. The 

Microsoft Windows 7,  Microsoft Windows Vista with service pack 2, and Microsoft 

Windows XP with Service Pack 3 operating systems are supported. Latest Debian 

Linux is supported.  

                                                 

1
 OpenTTCN SDK for C is compatible with Microsoft Visual Studio 2010 and Microsoft Visual Studio 

2008 in Windows platform and with GCC4 in Linux platform. 

2
 OpenTTCN SDK for C++ is compatible with Microsoft Visual Studio 2010 and Microsoft Visual 

Studio 2008 in Windows platform and with GCC4 in Linux platform. 

3
 OpenTTCN SDK for C# is compatible with Microsoft .NET Framework 3.5 / Mono and Microsoft 

Visual Studio 2010, Microsoft Visual Studio 2008 and Mono / MonoDevelop. 
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2 Release Highlights  of OpenTTCN Tester 2011 

 

OpenTTCN Tester 2011 is a new release version containing all changes from previous 

releases of OpenTTCN Tester. The following list contains highlights of new additions 

included in this version. See the Release Notes document for detailed list of changes 

from previous versions of OpenTTCN Tester. 

 

Four major new features of OpenTTCN Tester 2011 are: 

¶ Instantly-ready native TTCN-3 debugger, 

¶ GFT (Graphical Presentation Format) log viewer, 

¶ XML Schema to TTCN-3 translator, 

¶ all Java version of TTCN-3 TRI and TCI-CD interfaces for Java (new in 

4.1.2), 

¶ TTCN-3 TRI, TCI-CD, and TCI-TM interfaces for C++, and 

¶ TTCN-3 TRI and TCI-CD interfaces for C#. 

 

Highlights of features of previous version of OpenTTCN Tester included to 

OpenTTCN Tester 2011:  

¶ A graphical user interface simplifying test development and test management 

supporting: 

Á TTCN-3 test case editing, 

Á TTCN-3 syntax and semantic checking, 

Á TTCN-3 compilation, 

Á Test management - Execution of TTCN-3 test cases, and 

Á On-demand adapter startup. 

¶ Command-line tools for scripting and advanced use are included, 

¶ TTCN-3 Edition 4 (version 4.2.1) improvements for LTE support, 

¶ Unified installer architecture - All  tools and SDKs in one package, and 

¶ Bug fixes, performance improvements and usability improvements. 
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3 Prerequisite s for OpenTTCN Tester 

 

OpenTTCN Tester 2011 is available for modern PC computers running Microsoft 

Windows XP with Service Pack 3, Microsoft Windows Vista with Service Pack 2 and 

Microsoft Windows 7 operating systems.  

 

OpenTTCN Tester 2011 is a standalone package integrating functionality of popular 

OpenTTCN Tester product with an Eclipse-based TTCN-3 IDE. 

 

OpenTTCN Tester 2011 uses Java for the Eclipse components as well as parsing 

TTCN-3 and ASN.1 modules. For these reasons you need to have Java 6 Runtime 

Environment or newer installed. OpenTTCN recommends using the latest version of 

Java 6 JRE. Current version of OpenTTCN Tester requires 32 bit version of Java. If 

you are developing adapters with the OpenTTCN Java SDK, you must install the Java 

Development Kit (JDK). 

 

You can download a Java Runtime Environment (JRE) or a Java Development Kit 

(JDK) from: htt p://java.sun.com . 

  

http://java.sun.com/
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4 OpenTTCN Tester System Overview  

 

OpenTTCN Tester consists of a Server, a User Interface, one or more SUT and 

Platform Adapters, and one or more Coding and Decoding adapters. The Server is 

used to execute test specification and it implements the TTCN-3 Executable (TE) 

function described in the TTCN-3 architecture. The Graphical User Interface (GUI) is 

used to perform test management operations and to control the testing. It implements 

the Test Control (TC) and Test Logging (TL) interfaces described in the TTCN-3 

architecture. The SUT and Platform adapters adapt the tester for certain application 

domain that is specified by a test suite and implement the corresponding function 

described in the TTCN-3 architecture. The Coding and Decoding provides translation 

between abstract TTCN-3 data and transfer syntax used by the application on the 

wire. 

4.1 System Services 

 

The server part of OpenTTCN Tester, also called the Server or System Services, 

consists of one or more processes that implement necessary functionality to control, 

store, and execute test specifications. 

 

System services shall be running before other parts of the test system are started and 

while the rest of the test system is running. They are started automatically by the 

Graphical User Interface, but must be started by hand for command-line use. 

4.2 User Interfaces  

 

The user interface part of OpenTTCN Tester consists of alternative user interfaces 

that implement necessary functionality to perform test management operations and to 

control the testing. The graphical user interface is the normal method of operating the 

test system. OpenTTCN command-line utilities are also described in this document, 

but they are intended for advanced users only. Alternatively a custom user interface 

implemented using TCI-TM interfaces can be used. 
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Division of OpenTTCN Tester to user interface and server parts allows separate 

evolution of these parts, and integration of customer specific test management 

software if desired. 

 

For simple scenarios use of the OpenTTCN provided graphical user interface is 

recommended. 

4.3 SUT and Platform Adapters  and Coding and Decoding 

 

The domain specific part of the OpenTTCN Tester, here called "SUT and Platform 

Adapters and Coding and Decoding", consists of one or more processes that 

implement necessary functionality to specialize a generic tester to a certain 

application domain and operating system platform.  

 

SUT adapter is used to create a concrete link between the Tester and the 

Implementation Under Test (IUT). Platform Adapter is used to extend the used testing 

language with external operations, and in some case implementing a platform specific 

timing mechanism. Coding and Decoding is used to encode all data sent and to 

decode all data received. Coding and Decoding can be implemented as a single 

separate server or implemented together with the SUT or Platform Adapter server. 

After these servers have been created for a specific test suite, a complete test system, 

"Means of Testing" (MOT) in ISO 9646 terms, has been created.   

 

The necessary SUT and Platform Adapters and Coding and Decoding can be provided 

by OpenTTCN Ltd, a value added reseller, integrator, or they could be created by the 

end-user with the OpenTTCN SDKs. 

 

These three classes of adapters, SUT Adapter, Platform Adapter, and Coding and 

Decoding, are described in the following sections. 
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4.3.1 SUT Adapter 

 

The SUT Adapter consists of one or more processes that implement necessary 

functionality to connect Implementation Under Test (IUT) to the Tester. Each of the 

processes in turn may implement one or more TTCN-3 ports defined in the test 

specification in abstract terms. Usually the implementation of the SUT Adapter 

consists of message decoder and encoder, and code that sends and receives messages 

to and from the used network hardware or connection. 

 

The SUT Adapter shall be started and registered only after the Server is already 

running. The SUT Adapter shall be unregistered and stopped before the Server is 

stopped. 

4.3.2 Platform  Adapter  

 

The Platform Adapter consists of one process that implements the TTCN-3 external 

functions defined in the test specification in abstract terms. The TTCN-3 external 

functions are an extension mechanism to add new operations to the testing language 

that cannot be otherwise specified. The Platform Adapter can be implemented in a 

separate process or it can be combined with one of the SUT Adapters. Usually, the 

Platform Adapter is combined with the SUT Adapter, if the TTCN-3 external 

functions are used to control the test system interface.  

 

The Platform Adapter shall be started and registered only after the Server is already 

running. The Platform Adapter shall be unregistered and stopped before the Server is 

stopped. 
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4.3.3 Coding and Decoding 

 

The Coding and Decoding consists of one or more decoding functions and one or 

more encoding functions that implement necessary functionality to convert abstract 

TTCN-3 values to desired transfer syntax and vice versa.  

 

The Coding and Decoding is normally implemented together with the TTCN-3 SUT 

Adapter or Platform Adapter needing its services. Alternatively a single standalone 

Coding and Decoding server can be registered that provides all encoding and 

decoding services for the test system. 

 

The standalone Coding and Decoding shall be started and registered only after the 

Server is already running. The standalone Coding and Decoding shall be unregistered 

and stopped before the Server is stopped. 
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5 Starting and Stopping OpenTTCN Tester 

 

You can start OpenTTCN Tester from the Windows Start menu under OpenTTCN 

Tester 2011. Your Windows desktop also has a new icon to start OpenTTCN Tester, 

if you chose to install it.  

 

On startup you will be prompted for your workspace location. The term workspace 

means the directory where all OpenTTCN Tester TTCN-3 projects, configuration 

settings and TTCN-3 files are stored. It is recommended to place the workspace in 

your home directory under the "OpenTTCN Tester 2011" folder. After your start 

OpenTTCN Tester, OpenTTCN Tester splash screen shown in the following 

screenshot is displayed.  

 

 

Figure 1: OpenTTCN Tester 2011 splash screen. 
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5.1 Selecting a Workspace  

 

When you select to start OpenTTCN Tester, the following dialog will be shown. You 

can now change the workspace directory by specifying a directory name that you 

want to use as your OpenTTCN Tester workspace directory.  

 

For example, you can place the workspace in your home directory under the 

"OpenTTCN Tester 2011" folder. This is the default recommended setting. This 

would be specified in the dialog as C:\Users\<your username>\OpenTTCN Tester 

2011\workspace (in Windows 7). Alternatively you can place the directory to your 

desired location by clicking on the Browse -button. 

 

 

Figure 2: Workspace launcher dialog. 

 

Every time OpenTTCN Tester starts, the application will ask you for the workspace 

you want to use. If you want to use the same workspace always, you can tick the ñUse 

this as the default and do not ask againò check box. 
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5.2 Installing OpenTTCN License Key  

 

When OpenTTCN Tester starts it checks if you have already installed OpenTTCN.lic 

license key and asks if you want to install the license key. The OpenTTCN.lic license 

key can be downloaded from https://www.openttcn.com/updates using the same 

account information that you used to download the OpenTTCN Tester software itself. 

 

If OpenTTCN.lic license key of OpenTTCN Tester is missing when you start 

OpenTTCN Tester, the application will ask you if you wish to install the license key 

using the following dialog. Please click Yes button to proceed installing the missing 

license key. Note that OpenTTCN Tester will  refuse to start until you install and 

activate a valid license key. 

 

 

Figure 3: License file installation dialog. 

 

If you answer No to the license installation request, you will be returned to the 

License Management screen where you can choose to try again or exit the program. 

 

When you answer Yes, the following Select license file dialog is shown. Navigate to 

the correct folder that contains the OpenTTCN.lic license key you downloaded. If you 

have downloaded the key using Windows 7, the license may be found from 

"C:\Users\<your username>\Downloads" directory by default. 

 

http://www.openttcn.com/updates
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Figure 4: Select license file dialog. 

 

5.3 Activating  OpenTTCN License Key 

 

Before the OpenTTCN license key can be used it needs to be activated. The activation 

is performed using Internet connection with the OpenTTCN Activation server. 

 

After you have installed OpenTTCN license key, OpenTTCN Tester checks if the 

license key needs activation and asks you if you want to activate the license key to the 

computer you are using. If you want to activate to the computer you are now using, 

please click Yes button to proceed with the activation. If you do not activate your 

license the software will not start and you will be returned to the License Management 

screen where you can install another license or exit the program. 

 

Note that activating the license key binds it to your computer and you cannot activate 

it on another computer. If you want to activate the license key to another computer 

instead, please click No button to cancel the activation. 
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Figure 5: License activation request dialog. 

 

If the activation is successful OpenTTCN Tester will start up. In the case of errors you 

will be returned to the License Management screen to resolve the problem. If you 

encounter internet connectivity problems and your network requires a proxy server, 

please refer to chapter 5.4. 

 

The License Manager looks like in the following screenshot. If you encounter 

problems with setting up your license, please contact OpenTTCN support using the 

support@openttcn.fi e-mail address. In your message please indicate your license 

keys OT ID number, the error message shown in red as well as the exact error details 

shown when you click the Details... button. 

 

mailto:support@openttcn.fi
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Figure 6: OpenTTCN license management window. 
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5.4 Proxy configuration  

 

If your network requires proxy settings, you might encounter problems when 

activating your license or with Online License Validation. Proxy configuration can be 

opened from the OpenTTCN License Management dialog. Later on you can access 

the proxy settings via the Window -> Preferences... menu item. It is available in the 

General -> Network Connections section. 

 

The proxy configuration looks as in the following picture. Here you can select Direct 

internet connectivity, Manual proxy configuration or use of the Native settings. 

 

 

Figure 7: Proxy configuration in preferences. 
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The simplest option is to select the active provider as Native so that the system 

settings will be used. If this does not work, you must inquire the correct proxy settings 

from your network administrator and configure the proxy with the Manual setting. 

 

5.5 Online License Validation  

 

If your license requires Online License Validation with the OpenTTCN license server 

and there is a problem with your network connectivity, you might encounter the 

following license error: 

 

Possible causes and ways to resolve these problems are: 

 

1) No internet connectivity. Please connect your computer to the internet. 

2) Erroneous proxy configuration. For instructions on configuring your proxy 

settings please refer to Chapter 5.4 Proxy configuration. 

Figure 8: License validation error. 
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3) Firewall configuration . You should configure your firewall to permit 

network communication from OpenTTCN Tester to the activation server. 

4) OpenTTCN license server is not available at this moment. You should try 

again momentarily to see if the issue has been resolved. Should your problem 

persist, please contact OpenTTCN support at support@openttcn.fi .  
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5.6 OpenTTCN Tester Running  

 

After OpenTTCN Tester has started the welcome screen is displayed. From this 

welcome screen you can select "Create example workspace" to import the TTCN-3 

Demo3, DNS, and ASN.1 example projects. These examples are a helpful 

introduction if you are new to TTCN-3, OpenTTCN and/or OpenTTCN Tester.  

 

You can also choose to start with an empty workspace by selecting "Go to 

workspace". 

 

 

Figure 9: OpenTTCN welcome screen during first start-up. 

 

If you wish to return to the welcome screen at a later date, you can find the 

OpenTTCN Tester Welcome Screen option in the help menu: 
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Figure 10: Re-launching OpenTTCN welcome screen from Help menu. 

 

After  the import is finished OpenTTCN Tester will be put in the default TTCN-3 

perspective. The term perspective means the TTCN-3 views and editors associated to 

certain tasks that are displayed. 

 

If you chose to import the workspace that came with OpenTTCN Tester installation as 

the workspace to use then OpenTTCN Tester should look like in the following 

screenshot. 

 

 

Figure 11: Automatic compilation after examples were added. 
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Starting OpenTTCN Tester also automatically starts seamlessly integrated 

OpenTTCN virtual machine component which is responsible for running TTCN-3 test 

cases. 

 

Clicking the Go to workspace button after importing the examples lets you enter the 

basic workbench for OpenTTCN Tester 2011. Here you can see the Navigator view 

on the left, where you workspace projects are located. In the center is the TTCN-3 

editor for editing test scripts and on the right is the Outline view that shows the high 

level structure of the current module. At the bottom is visible the Console view where 

Build Logs, Adapter Logs and Test Campaign Logs are stored and shown. 

 

 

Figure 12: Default TTCN-3 view of OpenTTCN Tester. 

 

In the tab folder with Console view is also Problems view, where compilation errors 

and warnings are placed when compiling, in addition to being displayed in the Build 

Log.  
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5.7 Stopping  OpenTTCN Tester 

 

OpenTTCN Tester can be stopped by selecting Exit from the File menu. When you 

exit OpenTTCN Tester the following dialog is displayed. 

 

 

Figure 13: Exit confirmation dialog.  

 

Every time OpenTTCN Tester stops, the application will ask you to confirm the exit. 

If you want the application to exit without confirmation, you can tick the ñAlways exit 

without promptò check box in the Confirm exit dialog. 

  

Closing the OpenTTCN Tester window also automatically asks whether to stop the 

system services component. 

 

 

Figure 14: OpenTTCN background services stop dialog. 
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OpenTTCN System Services is a background component used by all OpenTTCN 

tools. It is recommended to have it terminate with OpenTTCN Tester. If the system 

services are left running, subsequent OpenTTCN Tester startups will be faster, but 

some system resources will be consumed by the running services. NOTE: System 

Services are shared between OpenTTCN Tester instances, and if using multiple 

windows you should choose not to terminate them. System services are also required 

if you wish to utilize the command-line tools without the graphical user interface (can 

be also started separately with "ot start"). 

 

You can check "Remember my selection" to have your selection remembered and not 

be prompted again. You can still change your preference from the menu Window -> 

Preferences... and there navigate to OpenTTCN Tester -> Runtime tab shown in the 

image below. 

 

 

Figure 15: Runtime preferences. 
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6 Trying OpenTTCN Tester with Demo3 Example  

 

OpenTTCN Tester comes with three different examples to try: 

¶ Demo3 (TTCN-3 code demonstrating the use of many TTCN-3 keywords) 

¶ dns_example (TTCN-3 code using Domain Name System (DNS) as an 

example System Under Test (SUT)), see more about DNS in Wikipedia at: 

http://en.wikipedia.org/wiki/Domain_Name_System  

¶ ASN1 (demonstrating the use of ASN.1 definitions from TTCN-3 code) 

 

This chapter explains necessary steps to compile and to run the Demo3 example. The 

other examples can be run in a similar fashion. 

 

You can recompile all provided example TTCN-3 projects by selecting Project -> 

Cleané -> Clean all projects and click OK button. This will clean all TTCN-3 

projects causing automatic rebuilding of them by compiling all TTCN-3 files in these 

projects. When you first create the examples from the welcome screen, they should be 

automatically compiled. 

 

Alternatively, you can just clean the Demo3 project by selecting Project -> Cleané -

> Clean projects selected below, selecting Demo3 project, and then clicking OK 

button. This would have cleaned and automatically built the Demo3 project only. 

 

 

Figure 16: Clean projects dialog.  

http://en.wikipedia.org/wiki/Domain_Name_System
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After you have clicked OK button, OpenTTCN Tester invokes the OpenTTCN 

TTCN-3 just-in-time compiler. You can see the output of the compiler in the console 

of the TTCN-3 perspective of OpenTTCN Tester. 

 

After compiling the Demo3 project that came with OpenTTCN Tester you should get 

the same result as shown in the following screenshot: ñDemo3 ï 0 error(s), 0 

warning(s).ò 

 

 

Figure 17: Demo3 compilation results in build console view. 
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Now you are ready to run the examples. Let's run the test cases of Demo3 TTCN-3 

project. There are total 205 test cases in the Demo3 example TTCN-3 project. You 

can start the Demo3 test campaign, i.e. start execution of Demo3 test cases by 

selecting Run -> Run configurationsé and selecting Demo3 and clicking Run button. 

 

When the test campaign to run Demo3 test cases starts, the OpenTTCN Tester 

switches to a console that shows the produced detailed TTCN-3 test log. You can 

follow the log in the console in real time as testing progresses as seen below. 

 

 

Figure 18: Test log in text log view. 

 

When the test campaign to run Demo3 test cases has finished, the OpenTTCN Tester 

console shows you the end of the detailed TTCN-3 test log produced as shown in the 

above screenshot. The test results should match those in the image: 209 Pass verdicts, 

0 Fail verdicts, 0 Inconclusive verdicts, 0 None verdicts and 0 Error verdicts, totaling 

test results for 209 test cases. For further information, see the next chapter. 
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You can also switch to see the output of TTCN-3 adapter used in another console with 

the "Display Selected Console" button. Below you can see the adapter log. The 

"Display Selected Console" button is circled in red. 

 

 

Figure 19: Adapter output in adapter output console view. 
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6.1 Expected Results of Demo3 Test Campaign 

 

The Demo3 example project demonstrates the use of TTCN-3 keywords. 

 

The expected test results of the Demo3 test campaign are: 

 

Pass    Fail    Inconc    None    Error    Total    Duration  

211      0       0         0       0        211       00:0 0: 28 

 

There are 211 pass verdicts produced. The fail, inconc, none and error verdicts are not 

shown in the examples, but you are encouraged to modify the examples to product 

other test results as well. The Demo3 example is illustrating use of various TTCN-3 

keywords. 

 

The duration of the test campaign, here shown lasting thirty seconds, depends 

partially on the speed of your computer. The above test results are achieved in 

computer having one Intel Core 2 CPU 6700 @ 2.66GHz, 4GB RAM, and running 

64-bit Windows 7 operating system. 

 

6.2 Expected Results of dns_example Test Campaign 

 

The dns_example example project uses a real DNS server as System Under Test 

(DNS) and contains a simplified but functional TTCN-3 SUT adapter for running test 

cases. 

 

The expected test results of the dns_example test campaign are: 

 

Pass    Fail    Inconc    None    Error    Total    Duration  

1       0       0         0       0        1        00:00:01  
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6.3 Expected Results of ASN1 Test Campaign 

 

The ASN1 example project demonstrates the use of ASN.1 definitions from TTCN-3 

code. 

 

The expected test results of the ASN1 test campaign are: 

 

Pass    Fail    Inconc    None    Error    Total    Duration  

1       0       0         0       0        1        00:00:01  
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7 Starting a New TTCN-3 Project  

 

In the previous Chapter you have learned how to use and run pre-configured TTCN-3 

examples that come with OpenTTCN Tester. In this chapter, you will learn various 

tasks that are needed when creating and running your own TTCN-3 testing projects 

and test campaigns. 

 

The following chapters follow typical sequence how new testing project is set up. 

7.1 Creating a TTCN-3 Project  

 

If you want to work with a new set of TTCN-3 modules you need to create a TTCN-3 

project for them first.  

 

Create a new TTCN-3 project by selecting File -> New -> TTCN-3 Project. 

 

Set project name
4
 to the name you want (here ñExampleò) and click ñFinishò button. 

You can see the created Example project in the Navigator View of OpenTTCN Tester. 

 

                                                 

4
 The project name corresponds to the name of the testing session of previous versions of OpenTTCN 

Tester product.  
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Figure 20: New TTCN-3 project dialog. 

 

 

You have now created a new TTCN-3 project under the currently used workspace. 

The Location in the above New Project dialog shows you the file system directory 

location of the new project. The name of the TTCN-3 project can contain all the 

characters allowed for file and directory names for file system in the supported 

operating system. 

 

The newly created Example TTCN-3 project is shown in the end of the OpenTTCN 

Tester workspace navigator in the left side of your workbench, as seen in the 

screenshot at the bottom of this page. 

 

You do not have any TTCN-3 files in the TTCN-3 project yet. We see how new 

TTCN-3 files can be created in the Chapter 7.2. In Chapter 7.3 we learn how to 

import existing TTCN-3 files to your TTCN-3 project. 
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Figure 21: New ñExampleò project in navigator view. 
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7.2 Creating a TTCN-3 File 

 

If you want to write a new TTCN-3 module you need to create a TTCN-3 file for that 

TTCN-3 module first.  

 

Create a new TTCN-3 file by right-clicking the name of the TTCN-3 project you want 

the TTCN-3 file to be created in from the Navigator view and then select New -> 

TTCN-3 File (shown circled below). 

 

 

Figure 22: New TTCN-3 file pop-up menu. 

 

Set module name to the name you want (we choose the default, ñDemoModuleò, here) 

and click ñFinishò button. Note that the name is the module name and not the file 

name. The file will be named "ModuleName.ttcn" automatically. You can see the New 

TTCN-3 File dialog below. 
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Figure 23: New TTCN-3 file dialog. 

 

The New TTCN-3 File dialog also shows the TTCN-3 Project (here ñ/Exampleò) 

under which the new file will be created. You can also create template code with an 

simple test case skeleton and an example TTCN-3 control part
5
. Do this by ticking the 

ñCreate template codeò check box in the New TTCN-3 File dialog. 

 

You can only place one TTCN-3 module to one file. OpenTTCN recommends naming 

both the TTCN-3 module and the file using the same name. For example 

DemoModule TTCN-3 module would be placed to DemoModule.ttcn file. 

 

OpenTTCN and ETSI recommends using .ttcn file suffix for TTCN-3 files. 

OpenTTCN Tester 2011 automatically uses .ttcn suffix for newly created files. 

 

 

                                                 

5
 Please note that there can be only one TTCN-3 control part in one complete TTCN-3 test suite 

(collection of modules) and that the TTCN-3 control part must be the last top-level definition of the 

module according to TTCN-3 standard. 
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7.3 Importing  TTCN-3 File(s)  

 

If you already have TTCN-3 file(s) that you want to use you can import these files 

from some other location in the file system to the TTCN-3 project you are working 

on. 

 

Import existing TTCN-3 files by first selecting 

the TTCN-3 project you want the files imported 

to by clicking the project name in the Navigator 

view of the OpenTTCN Tester and then 

selecting Importé from the right-click context 

menu. 

 

Expand ñGeneralò and then select ñFile Systemò 

or "Archive File" by clicking the icons. Then 

click Next> button. 

  
Figure 24: Import dialog.  
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Select the files to be imported by first clicking Browse button and browsing and 

selecting the desired directory or archive file (here C:\temp\ttcn3) and clicking OK 

button. Then select the directory for import by placing a tick mark to the check box 

next to the directory name in the left pane of the Import from File system dialog. 

Alternatively you can select the individual files by placing the tick mark to the check 

box next to the file name in the right pane of the Import from File system dialog as 

shown in the image below. 

 

 

Figure 25: Import from file system dialog. 

 

Click the Finish button to start importing of the selected directories and/or files to the 

TTCN-3 project. 
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7.4 Creating a Parameter File  

 

Most test suites define module parameters to specify test system specific setup and to 

select optional features. The values of these parameters must be specified before 

executing a test campaign, which is done by defining their values in a module 

parameter file with the ".par" extension. 

 

To create a new parameter file you should first compile the desired test suite in 

OpenTTCN Tester. After this, you can right-click the target project and select New -> 

New TTCN-3 Parameter File to access the parameter file creation wizard. 

 

The New TTCN-3 Parameter File wizard will automatically create a module 

parameter file with the ".par" extension, and fill in information about all module 

parameters defined by the test suite as currently compiled. You should go through the 

generated file and set valid values for all parameters after this. In the wizard you can 

specify the Module name (which will also become the filename). If you tick the 

Uncomment default parameters and Uncomment undefined parameters options the 

parameter definitions will be uncommented with the value set to a default value or 

omit if no value is specified in the test suite. 
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Figure 26: Create new TTCN-3 parameter file dialog. 

T 

he generated parameter file contains documentation comments for the parameters 

defined. The following table explains the meaning of the documentation comments: 

 

@parameter Name of the parameter being defined. 

@typeclass Base TTCN-3 type of the parameter. 

@default Default value specified in the test suite. 

@recordfield Lists fields of a record type. Each line specifies one field, with 

field type first and field identifier second. 

@unionvariant Lists union variants. Each line specifies one variant, with 

variant type first and identifier second. 

@enumlabel Lists enumeration identifiers. Each line specifies one identifier. 

 

7.5 Compiling TTCN-3 Code 

 

OpenTTCN Tester automatically compiles TTCN-3 code when the TTCN-3 file is 

saved, if compilation is not explicitly disabled for the select TTCN-3 file. By default 
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files with file suffix of .ttcn, .ttcn3 and .asn1 are compiled automatically when the 

file is saved. 

 

You can disable compilation for TTCN-3 files by clicking the file in the navigator, 

pressing right mouse button, and selecting OpenTTCN Compiler -> Disable 

Compilation from the displayed context menu. After selecting Disable Compilation 

the icon of the TTCN-3 file is changed from OpenTTCN icon to include a small red 

and white ñno entryò traffic sign. 

 

When you change a TTCN-3 file in the editor, the application compiles it 

automatically when the file is saved. This feature is called Automatic compilation and 

is enabled by default. The feature can be toggled from the Project menu by changing 

the Build automatically option. If this option is disabled you can run a build of your 

source code by selecting Project -> Build All. 

 

OpenTTCN recommends keeping automatic compilation enabled, unless working on 

very large and complex test suites where builds may take a significant amount of 

time. This should not usually be an issue as only the changed files and their 

dependencies are recompiled with automatic compilation. 

 

A changed file that has not yet been saved is indicated by ñ*ò before the file name in 

the TTCN-3 editor panel title. 
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Figure 27: Editing a new TTCN-3 module. 

 

You can also select Project -> Clean... from menu bar and click OK button to clean 

all projects. This causes a rebuild of all TTCN-3 projects that have some TTCN-3 

files selected for compilation. 

 

In the next page we write a small Hello world test case to be used in the examples 

shown in the following Chapters. 
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We write a small Hello world test case consisting of log statement to display ñHello 

worldò and setverdict statement to set the verdict of this test case to pass as an 

example. This test case is shown in the following screenshot. 

 

After you save the file, you should see the ñExample ï 0 error(s), 0 warning(s)ò 

message in the Console. 

 

 

Figure 28: Compiling a new TTCN-3 module. 

 

 

The TC_HelloWorld test case is now checked for syntax and semantic errors and 

compiled into the System Services repository ready to be executed by OpenTTCN 

virtual machine.  



 

Page 44 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

7.6 Setting TTCN-3 Adapter Configuration (External Tools 

Configuration ) 

 

You can set up a new external tools configuration for running OpenTTCN Adapter 

built with one of the OpenTTCN SDKs by creating a new launch configuration. 

 

Select Run -> External Tools -> External Tools Configurationsé and then click New 

launch configuration icon button to create a new TTCN-3 test campaign launch 

configuration.  

 

Then you should set information correctly for the Name, Location, Working 

Directory, and possible Arguments. In the screenshot below we use the robo adapter 

included with the OpenTTCN Tester distribution which echoes all messages sent to it 

back to the test system. 
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Figure 29: External tools configuration dialog for configuring a new OpenTTCN adapter set-up. 

 

Name: Change the ñNew configurationò to descriptive name of your adapter 

configuration. Here: Example_Adapter 

 

Location: Give the path name to the executable that you use as your TTCN-3 adapter. 

Here: ${RoboBin} 

 

Working Directory: Give the directory name that you want to use as working the 

directory for your TTCN-3 adapter executable. 

Here: ${workspace_loc:/Example} 

 

Arguments: Give the possible command-line arguments for the TTCN-3 adapter 

executable to be started. Here: -s ${OpenttcnAddress}:Example TRI TRI 
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You could also use ${OpenttcnStartingSession} instead of "Example" above to 

automatically fill in the starting session when the adapter is launched with a test 

campaign. 

 

7.7 Setting Up TTCN-3 Test Campaign (Run Configuration)  

 

You can set up a new run configuration for running TTCN-3 test campaign by 

creating a new launch configuration. 

 

Select Run -> Run configurationsé and then click New launch configuration icon 

button to create a new TTCN-3 test campaign launch configuration.  

 

Then you should set information correctly for at least the Name and for the Main, Test 

Plan, and Adapters panels. 
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Figure 30: Run configurations dialog for configuring a new test campaign. 

 

Name: Change the ñNew configurationò to a descriptive name of your test campaign. 

Here: Example_Campaign 

 

Main: Select the Project to match the TTCN-3 Project you want to use for this 

campaign. Here: Example 

 

Test Plan: Select Run control part, Run all test cases, or Run selected test cases 

depending on your needs. 
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Adapters: Select OpenTTCN TTCN-3 adapters you want to be automatically started 

for this test campaign from the list. You can add new adapter configurations to the 

displayed adapter list as explained in Chapter 7.6. After adding the adapter 

configuration, complete your test campaign set-up by selecting the Adapters to start 

up automatically for the test campaign. Here: Start the following adapters 

automatically with Test Campaign and Example_Adapter selected from the Adapters 

list. 

 

 

Figure 31: Configuring start -up of adapters for a test campaign. 
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7.8 Running TTCN-3 Test Cases 

 

You can run one or multiple test cases by using the test campaign set-up you have 

created in Chapter 7.7. 

 

Select Run -> Run Configurations and then select one of the test campaigns (under 

OpenTTCN Test Suite) and click Run button.  

 

The detailed TTCN-3 test log will be displayed in the Console and you can scroll the 

test to see the details. The Console in the next screenshot shows the TTCN-3 test log 

produced by running the Hello world example TC_HelloWorld test case. 

  

Figure 32: Viewing test log in test run console view 
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8 Analyzing test results  

 

This section explains tools OpenTTCN Tester provides to simplify analyzing test 

results, whether they are passes or fails. 

 

8.1 Stack trace view 

 

A Stack trace is a snapshot of program execution showing the function call stack. 

Stack traces are a useful debugging tool for complex test suites, where many levels of 

functions are used. The OpenTTCN Tester stack trace view enables a test 

management system to send  the context in which a fail verdict occurred to the 

graphical user interface, allowing a test suite writer or tester to quickly see where the 

failure occurred. 

 

The stack trace view requires communications from the test management application 

to receive information about stack traces. Please refer to your test system vendors 

manual to see if they support this feature. 
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The screenshot shows a part of TTCN-3 code that set a fail verdict, a stack trace 

visible in test log that was produced as a result of the verdict and the stack trace view 

at the bottom. The user can quickly jump around in the source code by double-

clicking the items in the stack trace view. 

 

 

Figure 33: Stack trace view. 

 

Your stack traces are saved between sessions automatically. To delete a stack trace, 

press the  -button. To clear all stack traces press the  -button. 
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9 Java adapter development using OpenTTCN Tester 2011 GUI 

 

9.1 Overview  

 

If you installed the complete package including SDK for Java, the Tester 2011 GUI 

may be used for Java adapter development. This is done using the popular Eclipse 

Java Development Tools, which are included in the package. This chapter provides a 

tutorial to the Java development by going through the examples included with the 

OpenTTCN Java Development Kit. 

 

To begin with, let's assume that you have OpenTTCN Tester 2011 running and you 

have created the example workspace from the welcome screen. In order to develop 

TTCN-3 adapters using Java, we have a couple of steps to be performed: 

 

1. Create a Java project or import an existing project to the workspace. In this 

example we import existing projects. 

2. Setup the build path to OpenTTCN SDK for Java library and corresponding 

javadoc documentation. 

3. Start writing Java code! 

 

9.2 Importing a Java project  

 

Because some of the OpenTTCN Java development kit examples are supplied as 

Eclipse projects, they can be imported into the workspace as-is.  From the main menu, 

select File -> Import...  and an import wizard will be launched. In this wizard, select 

General -> Existing Projects Into Workspace as shown in the next figure.  
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Figure 34: Import dialog.  

 

After clicking Next in the import dialog, you will be presented with the Import 

Projects window. There are three points of interest, illustrated in the subsequent 

figure: 

¶ Root directory. Select the OpenTTCN Tester 2011 Installation 

Path/sdk4java/examples. 

¶ Project selection. This list contains the Eclipse projects that were found inside 

the root directory. Here we can see the hello example. 

¶ Copy projects into workspace. Checking this selection instructs eclipse to 

create a local copy of all the data files. This is recommended in order to 

prevent potential problems with file access permissions as well as to keep 

things simple: all your data files are inside the workspace.
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Figure 35: Importing adapters projects to workspace. 

 

Select the projects as shown in the figure and click Finish to proceed with the import.  

 

9.3 Setting up Java compilation  

 

After the import finishes, you will be taken back to the main workbench view. In this 

case, the examples contain both TTCN-3 code and Java code. The example projects 

have the OpenTTCN nature and compiler enabled by default, and therefore the 

TTCN-3 code will be built straight after import. This can be seen in the build log. To 

enable Java compilation, there are a couple of steps to be taken: 
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¶ Switch to Java perspective 

¶ Setup path to OpenTTCN SDK libraries 

 

To switch the perspective, click on the Open perspective button in the top-right 

corner, as shown in the next figure. 

 

Figure 36: Switch perspective button. 

 

From the perspective list select Other... and then Java from the list. In the Java 

perspective, you will notice an error icon at the freshly imported projects, as well as 

several problems in the Problems tab. These are illustrated in the next figure. 
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Figure 37: Problems tab for adapter compilation problems. 

 

These problems are caused by not having the build path set to OpenTTCN SDK 

libraries, and may be corrected by setting up the build path as follows: 

 

1. Right-click on the project java_hello_example 

2. Select OpenTTCN Tester -> Setup Java SDK build path 

 

After this, the errors will disappear and the adapters will be built automatically. At 

this point the IDE will compile either TTCN-3 or Java files, depending on the 

perspective. To go back to editing TTCN-3, select the TTCN-3 perspective at the top 

right corner.  In order to run the examples entirely within the GUI, there is one more 

step to be taken: Launch configurations. Chapters 7.6 and 7.7 describe the process of 

creating the launch configurations, and the next section discusses the options specific 

to Java adapters developed inside the OpenTTCN Tester 2011 GUI. 
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9.4 Running Java adapters 

 

First of all, it is important to note that the .bat script files inside the example projects 

are not suitable for running the adapter, compiling the test suite or running the tests 

from the GUI. The .bat files are only intended to be used from the command line. 

 

Compared to other adapters, the Java adapters can be considered somewhat a special 

case. There are two reasonable options for running them, each with their benefits and 

downsides: 

 

Option 1: OpenTTCN adapter launch configuration  

 

Adapter launch configurations are described in chapter 7.6, and the same procedure 

may be applied for Java adapters that are built within the GUI. Once set up, this 

method allows convenient, automatic adapter startup during the test campaign startup. 

However, the setup requires moderate amount of work, making it less ideal for a 

quick test. On other hand, the option 2 described below is quick and convenient to set 

up, but requires manual startup of the adapter before test execution. 

 

In the first approach, the OpenTTCN adapter configuration must start java.exe (as 

opposed to the typical adapter.exe) with appropriate arguments which will instruct the 

JVM to start the adapter. This procedure is not really specific to OpenTTCN Tester, 

and therefore is not covered here in detail, but the start_adapter.bat supplied with the 

examples may be used as a starting point. Java.exe must be provided with path to the 

OpenTTCN.SDK.jar, jacorb.jar, slf4j-api-1.5.6.jar, and slf4j-jdk14-1.5.6.jar as well as 

to the javac output directory. 

 

Option 2 : Start as Java application 

 

The second approach utilizes the built-in Eclipse Java Development environment 

tools to launch the application. To begin, click the arrow at the Run as.." toolbar 
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button to open the launch configurations and select the Run Configurations.." menu 

item. This is illustrated in the following figure.  

 

Figure 38: Run configuration for Java adapter. 

 

In the Run Configurations window, right-click the Java Application and select New. 

Fill the relevant fields, particularly in the Main tab. This adapter requires no 

arguments, and therefore we only need to fill the main tab, as shown below. 



 

Page 59 of 95  

 

 

OpenTTCN Tester 2011 User Guide 

 

© 2011 OpenTTCN Ltd. All rights reserved. 

 

Figure 39: Setting up a run configuration for Java adapter. 

 

Once the adapter run configuration is set up, we may proceed to actually executing 

the example. Following the instructions in chapter 7.7, set up also a run configuration 

(OpenTTCN Test Suite) for the java_hello_example project. Only the project has to 

be selected, all other default values are fine. It is also recommended to select the 

"Display in favorites menu" option on the Common tab. 

 

Finally, go back to the TTCN-3 perspective and then launch first the adapter and then 

the test execution from the Run as... dropdown menu on the toolbar. If everything was 

configured correctly, the adapter will start in one of the windows inside the Console 

view (as described in chapter 6), and the test execution log is shown in another 

console view. The test will fail with a timeout if no SUT is running. Please refer to 

README.txt and start_sut.bat found in the SDK installation hello example directory 

for instructions on starting the SUT used in this example. 
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10 Command-line Tools Quick Reference  

 

The next two pages give short ñhow-toò instructions for people who want a quick start 

into the command-line tools of OpenTTCN Tester. You are recommended to use the 

graphical user interface for normal operation, the command-line is provided for the 

convenience of advanced users. 

 

10.1 Controlling System Services 

 

Multiple test campaigns can be run while the testing server is running. In Linux 

platform the testing server can be started on the operating system start-up, and kept 

running until rebooted. The graphical user interface automatically starts the system 

services, and requires them to be running during operation. 

 

Start a testing server for a single session:   ot start 

Stop a testing server:      ot stop 

Finding out OT ID that identifies your license key:  ot id 

 

10.2 Session Management  

 

Sessions correspond to the project name in the graphical user interface. Test 

scripts are automatically imported to a session with the name of the project when 

compiled. You should select a session name that does not conflict with OpenTTCN 

Tester GUI project names for command - line use.  

 

Create a testing session:  session create SessionName3 

List available testing sessions: session list 

Delete a testing session:  session delete SessionName3 

10.3 Loading modules  

 

Loading a TTCN-3 module: importer3 load SessionName3 ModuleName.ttcn 

Loading an ASN.1 module: importer3 load SessionName3 ModuleName.asn1 
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10.4 Running test  cases 

 

Running all test cases of a module: tester run SessionName3 @all 

Running TTCN-3 control part: tester run SessionName3 @control 

Running a test case:   tester run SessionName3 TC_while 

Running a list of test cases: tester run SessionName3 TC_if TC_for TC_while 

 

10.5 Loading values of module or test  suite parameters  

 

Loading of values of module parameters needs to be done only if values differing 

from the default values of module parameters are used. 

 

Loading TTCN-3 

module parameters: importer3 parameterize SessionName3 ParameterFile.ttcn 

 

10.6 Handling  errors  

 

Stopping a test case/tester:    Press Control-C 

(For example if a test case hangs) 
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10.7 Typical Commands Sequences 

 

The testing server shall be running before issuing any of the following commands. 

Instructions how to start a testing server are given in section 10.1, above. 

 

1. Commands given to start a SUT Adapter and register the adapter to a testing 

session 

¶ depends on the SUT Adapters used
6
, for example: startif  

¶ a testing session name to where the adapter is registered is specified in the 

above start-up script, after this registration the tester and the SUT Adapter 

can communicate; the tester can issue a ñmapò operation to SUT Adapter, 

and communication using ñsendò, ñreceiveò, and procedure-based 

communication operations is possible 

2. importer3 load SessionName3 ModuleName.ttcn 

¶ a test suite in a file ModuleName.ttcn is loaded to SessionName3 session 

3. tester run SessionName3 @all 

¶ all test cases in the test suite loaded to SessionName3 session are executed 

  

                                                 

6
 By OpenTTCN Ltd convention, the test system interface start-up command is put to a file that is 

called in Linux and Mac OS X ñstart_adapter.sh ò or ñstartif.sh ò, and in Windows 

ñstart_adapte r.bat ò  or ñstartif.bat ò. 
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11 Testing Using OpenTTCN Tester command -line  

 

Testing using OpenTTCN Tester command-line utilities follows seven steps: 

 

1. Starting a Test System (if it is not running already), 

2. Selecting a Testing Session, 

3. Setting Up a Tester for Testing New Implementation, 

4. Checking Feasibility of Starting Full Testing, 

5. Running All Tests, 

¶ Stopping a Test Campaign 

6. Reviewing Tests Results, 

7. Stopping a Test System (if no further tests are to be run). 

 

This chapter describes how to accomplish these steps. 

11.1 Starting Test System 

 

A complete OpenTTCN Tester based test system consists of the server part of 

OpenTTCN Tester, and SUT and Platform Adapters. 

 

To start an OpenTTCN test system you need to perform the following operations in 

sequence: 

 

1. Start the server part of OpenTTCN Tester, 

2. Start SUT and Platform Adapters, and optionally standalone Coding and 

Decoding. 
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11.1.1 Starting the Server Part of OpenTTCN Tester  

 

Starting the server part of an OpenTTCN Tester is the first step to start an OpenTTCN 

test system. 

 

Instructions:  

Issuing ñot startò command starts the server part of an OpenTTCN Tester. 

 

During the start-up of the server part of the OpenTTCN Tester, the ñot startò 

command launches an ñopenttcndò daemon process in the background and returns 

silently if no errors occurred. 

 

11.1.2 Starti ng SUT and Platform Adapters and Coding and Decoding  

 

Starting the SUT and Platform Adapters and standalone Coding and Decoding is the 

last step to start an OpenTTCN test system. 

 

The start-up instructions for the SUT and Platform Adapters and standalone Coding 

and Decoding depend on the specific adapters. Please consult the end-user 

documentation of the adapters for instructions how to start them. Coding and 

decoding co-located in another adapter is started together with the adapter in question. 

 

Generic start-up instructions for SUT and Platform Adapters and Coding and 

Decoding usually include starting the executable(s) that implements the SUT Adapter, 

the Platform Adapter, and the Coding and Decoding, and the adapters register 

themselves directly to a specific testing session.  
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11.2 Selecting Testing Session 

 

If the OpenTTCN Tester you are using is a part of a complete test system coming 

from integrator or value added reseller, the test system usually comes with a number 

of pre-configured testing sessions and you can select the testing session you want to 

use by specifying the testing session name for the commands that you issue. The first 

step you can do is to find out a list of available testing sessions. 

 

Instructions to list available testing sessions: 

Issuing ñsession listò command displays a list of available testing sessions. 

 

When you have found out the name of the test session, this testing session name is 

specified as the second parameter for each command, i.e. ñimporter3 load Demo3 

demo3.ttcnò, ñtester run Demo3 @allò, etc. 

 

A user of OpenTTCN Command-Line Utilities may work with multiple currently 

active testing sessions at a time. A user can create and delete sessions, and ask a 

current status of a session. A testing session holds information about used modules, 

values of module parameters, and addresses of SUT and Platform Adapters and it can 

be referred by a testing session name. 

 

Sessions correspond to projects in the graphical user interface. Any changes to the 

session from the command line will also change the session in the graphical user 

interface. 

 

Instructions to create a testing session: 

Issuing ñsession create Demo3ò command creates a new testing session with a name 

ñDemo3ò. 
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Instructions to ask a current status of a testing session: 

Issuing ñsession status Demo3ò command shows the current status of an existing 

testing session with a name ñDemo3ò. 

 

Instructions to delete a testing session: 

Issuing ñsession delete Demo3ò command deletes an existing testing session with a 

name ñDemo3ò. 

 

11.3 Loading  (Compiling) TTCN -3 and ASN.1 Modules 

 

New test suites including TTCN-3 and ASN.1 modules needs to be loaded to 

OpenTTCN test suite repository before testing can be performed. The loading process 

includes syntax check, semantic checks, and compilation of the source code to 

intermediate OpenTTCN FS format that can be used by test components 

implementing OpenTTCN virtual machine. When the test case is started the final just 

in time type of compilation is performed by the test component from the intermediate 

OpenTTCN FS format taken from the test suite repository. 

 

The test suites and TTCN-3 and ASN.1 modules are held in the OpenTTCN test suite 

repository until they or the test session they are held is erased. 

 

Loading a TTCN-3 module: importer3 load SessionName3 ModuleName.ttcn
7
 

Loading an ASN.1 module: importer3 load SessionName1 ModuleName.asn1 

 

Instructions to load a new TTCN-3 module: 

Loading a new TTCN-3 module is a simple one step process, loading a module to a 

test suite repository that is associated to a testing session. Instructions to perform this 

are in the following. 

  

                                                 

7
 ETSI recommends ñ.ttcnò file prefix to be used for files storing TTCN-3 modules written in TTCN-3 

Core Language. 
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Issuing ñimporter3 load Demo3 demo3.ttcnò command loads a module using 

TTCN-3 core notation format from a file ñdemo3.ttcnò to a testing session with a 

name ñDemo3ò. 

 

Instructions to load multiple TTCN-3 modules to the same testing session: 

Multiple TTCN-3, modules can be loaded to the same testing session. Multiple 

modules can be loaded by placing all loaded modules to same list and invoking a 

single ñimporter3 loadò command. In this case all dependencies are automatically 

resolved between the modules based on correct TTCN-3 import statements included 

in the modules. 

 

Example: Loading multiple modules at once: 

 

importer3 load ModuleDemo mod1.ttcn mod2.ttcn mod3.ttcn 

 

Multiple modules can be loaded by invoking separate ñimporter3 loadò commands for 

each TTCN-3 module. In this case, the user needs to make sure that the modules are 

loaded in such order that all dependencies can be resolved between the modules. This 

means that a module can be loaded only if you have already loaded modules that this 

new module is dependent on. 

 

Example: Loading multiple modules in sequence: 

 

importer3 load ModuleDemo mod1.ttcn  

importer3 load ModuleDemo mod2.ttcn  

importer3 load ModuleDemo mod3.ttcn  

 

The above example assumes that mod1.ttcn is totally independent of other two 

modules, the mod2.ttcn can depend on mod1.ttcn, and the mod3.ttcn can depend on 

mod1.ttcn and mod2.ttcn. 

 

Instructions to load a new ASN.1 module: 
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Loading a new ASN.1 module is a simple one step process, loading a module to a test 

suite repository that is associated to a testing session. Instructions to perform this are 

in the following.  

 

Issuing ñimporter3 load asn1 DemoTypes.asn1ò command loads a module using 

ASN.1 syntax format from a file ñDemoTypes.asn1ò to a testing session with a name 

ñasn1ò.  

 

Multiple ASN.1 modules can be loaded to the same testing session. The ASN.1 

modules need to be loaded before any TTCN-3 modules that are depended on the 

ASN.1 definitions. 

 

11.4 Setting Up Tester for  Testing New Implementation  

 

When a new Implementation Under Test (IUT) is tested using OpenTTCN Tester 

command-line tools, you need to inform the OpenTTCN Tester about the special 

implementation options and implementation specific values this new implementation 

is using in order to specialize the used test suite for testing this particular 

implementation. 

 

This process of information the tester about which optional features are implemented 

and which specific values are used when a range of values are allowed by the standard 

is called Test Parameterization. 

 

In the Test Parameterization, the claimed implemented optional capabilities and 

specific values used in the Implementation Under Test are first recorded in the 

Protocol Implementation Conformance Statement (PICS) document that is then used 

to give correct values to module parameters. The module parameters are then used to 

parameterize the used Abstract Test Suite (ATS) so that it can be used for testing. 

 

Similarly, some extra information needed for testing is first recorded in the Protocol 

Extra Information for Testing (PIXIT) document that is then used to give correct 
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values to some module parameters. This extra information may include addresses and 

description of some capabilities of the test system. 

 

Preparations: 

 

1. Fill in a PICS Proforma document producing a PICS document 

2. Fill in a PIXIT Proforma document producing a PIXIT document 

3. Extract values of module parameters from the filled PICS and PIXIT 

documents to a module parameters file. The module parameters file is in 

TTCN-3 Core Language format and gives a list of values of module 

parameters with their name, type, and value. The values used shall describe 

properties of the Implementation Under Test or the test system. 

 

Instructions to load values of TTCN-3 module parameters: 

Loading a new set of values of TTCN-3 module parameters is a simple one step 

process, loading a set of values of module parameters to a parameter repository that is 

associated to a testing session. Instructions to perform this are in the following. 

 

Issuing ñimporter3 parameterize Demo3 parameters.ttcnò command loads a new 

set of values of module parameters from a file ñparameters.ttcnò to a testing session 

with a name ñDemo3ò. 

 

If no syntax errors are found in the parameters, the values of the module parameters 

are loaded to testing session. Otherwise, the command will display an error message 

to show the error details. 
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11.5 Checking Feasibility of Starting Full Testing  

 

Before starting a full Test Campaign, it is better to check if this is feasible. This can 

be simply done by selecting a couple of test cases with simple test purposes that any 

stable Implementation Under Test should handle. These test cases are called Basic 

Interconnection Tests (BIT) which are simple tests selected from the whole set for this 

purpose. If the most simple test cases found errors or there is a test system set-up 

problem that is detected, there is no use continue testing further, before these 

problems are first corrected. 

 

Instructions:  

First, start those test cases with ñtester runò command that you want to run as Basic 

Interconnection Tests. Look for the list of these test cases in the end-user 

documentation of your test system. 

 

For example, issuing ñtester run Demo3 TC_1 TC_2ò command starts testing using 

information in ñDemo3ò testing session, and starts a list of test cases as specified in 

the end of the command, here two test cases, ñTC_1ò, and ñTC_2ò are started. 

 

If all of these simple test cases show ñpassò verdict, you are more ready to run the 

remaining test cases. Any ñfailò verdicts usually indicate problems in the 

Implementation Under Test. Any ñinconcò verdicts usually indicate problems in the 

test system set-up. 

 

11.6 Running All Tests  

 

In the conformance testing of a protocol, it is customary to run all possible test cases 

as the testing can be automated. 

 

Instructions to run all TTCN -3 test cases: 

Issuing ñtester run Demo3 @allò command starts testing using information in 

ñDemo3ò testing session, and starts all test cases in the test suite associated with the 




















































